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Notice: Every effort was made to ensure that the information in this document was accurate 
at the time of printing. However, information is subject to change without notice, 
and PSIBER DATA reserves the right to provide an addendum to this document with 
information not available at the time that this document was created.

Copyright: © Copyright 2013 PSIBER DATA. All rights reserved. PSIBER DATA, and its logo 
are trademarks. All other trademarks and registered trademarks are the property 
of their respective owners. No part of this guide may be reproduced or transmitted 
electronically or otherwise without written permission of the publisher.

Trademarks: PSIBER DATA and FiberXpert OTDR 5000 (applied for trademarking) are trademarks or 
registered trademarks of PSIBER DATA.

Microsoft, Windows, Windows CE, Windows NT, and Microsoft Internet Explorer are 
either trademarks or registered trademarks of Microsoft Corporation in the United States 
and/or other countries.

Netscape Navigator is a trademark or registered trademark of Netscape

Communications Corporation in the United States and other countries.

Specifications, terms, and conditions are subject to change without notice. All 
trademarks and registered trademarks are the property of their respective companies.

WEEE Directive 
Compliance: 

PSIBER DATA has established processes in compliance with the Waste Electrical and 
Electronic Equipment (WEEE) Directive, 2002/96/EC.

This product should not be disposed of as unsorted municipal waste and should be 
collected separately and disposed of according to your national regulations. In the 
European Union, all equipment purchased from PSIBER DATA after 2005-08-13 can 
be returned for disposal at the end of its useful life. PSIBER DATA will ensure that all 
waste equipment returned is reused, recycled, or disposed of in an environmentally 
friendly manner, and in compliance with all applicable national and international waste 
legislation.

It is the responsibility of the equipment owner to return the equipment to PSIBER DATA 
for appropriate disposal. If the equipment was imported by a reseller whose name or 
logo is marked on the equipment, then the owner should return the equipment directly to 
the reseller.

Instructions for returning waste equipment to PSIBER DATA can be found in the 
Environmental section of PSIBER DATA’s web site at www.Psiberdata.com.
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The FiberXpert OTDR 5000 of PSIBER DATA provides a handheld OTDR for the construction, turn-up and maintenance 
of fiber networks.

The topics discussed in this chapter are as follows:

–    “Purpose and scope” on page xvi
–    “Assumptions” on page xvi
–    “Technical assistance” on page xvi
–    “Conventions” on page xvii

ABOUT THIS GUIDE
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About This Guide
Purpose and scope

Purpose and scope
The purpose of this guide is to help you successfully use the FiberXpert OTDR 5000 features and capabilities. This 
guide includes task-based instructions that describe how to install, configure, use, and troubleshoot the FiberXpert 
OTDR 5000.

Additionally, this guide provides a complete description of PSIBER DATA’s warranty, services, and repair information, 
including terms and conditions of the licensing agreement.

Assumptions
This guide is intended for novice, intermediate, and experienced users who want to use the FiberXpert OTDR 5000 
effectively and efficiently. We are assuming that you have basic computer and mouse/track ball experience and are 
familiar with basic telecommunication concepts and terminology.

Technical assistance
If you need assistance or have questions related to the use of this product, call or e-mail PSIBER DATA’s Technical 
Assistance Center for customer support.

Table 1 Technical assistance centers

Change accordingly

Region Phone number

Americas Telecom Products 866 228 3762 World Wide: 301 353 1550 tac@Psiber Data.com

Europe, Africa, and Mid-East +49 (0) 7121 86 1345 (Europe)  
+33 (0) 1 30 81 50 60 (PSIBER DATA 
France)

hotline.europe@Psiber Data.com 
support.france@Psiber Data.com

Asia and the Pacific Southeast Asia,  
Australia, and New Zealand

+852 2892 0990 (Hong Kong) 
+86 10 6833 7477 (Beijing-China)

All others 866 228 3762 tac@Psiber Data.com

During off-hours, you can request assistance by doing one of the following:

–    leave a voice mail message at the Technical Assistance number in your region
–    e-mail Technical Assistance Center, support@Psiber-Data.com
–    submit your question using our online Technical Assistance Request form at www.PsiberdData.com.
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Conventions
This guide uses naming conventions and symbols, as described in the following tables.

Table 2        Typographical conventions

Description Example

User interface actions appear in this typeface. On the Status bar, click Start.

Buttons or switches that you press on a unit appear in this TYPEFACE. Press the ON switch.

Code and output messages appear in this typeface. All results okay

Text you must type exactly as shown appears in this type- face. Type: a:\set.exe in the dia- log box

Variables appear in this type- face. Type the new hostname

Book references appear in this typeface. Refer to Newton’s Telecom Dictionary

A vertical bar | means “or”: only one option can appear in  
a single command.

platform [a|b|e]

Square brackets [ ] indicate an optional argument. login [platform name]

Slanted brackets < > group required arguments. <password>

Table 3        Keyboard and menu conventions

Description Example

A plus sign +  indicates simultaneous keystrokes. Press Ctrl+s

A comma indicates consecutive key strokes. Press Alt+f,s

A slanted bracket indicates choosing a submenu from menu. On the menu bar, click Start >  
Program Files.

Table 4        Symbol conventions

This symbol represents a general hazard.

This symbol represents a risk of electrical shock.

NOTE
This symbol represents a Note indicating related information or tip.

This symbol, located on the equipment or its packaging indicates that the equipment must not be 
disposed of in a land- fill site or as municipal waste, and should be disposed of according to your 
national regulations.

Table 5        Safety definitions

WARnInG
Indicates a potentially hazardous situation which, if not avoided, could result in death or serious 
injury.

CAUTIOn
Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate 
injury.
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This chapter provides a general description of the FiberXpert OTDR 5000. Topics discussed in this chapter include the 
following:

–    “Unpacking the instrument” on page 2
–    “About the FiberXpert OTDR 5000” on page 2
–    “Main features” on page 3
–    “Hard keys and Indicators” on page 5
–    “Power Supply” on page 7

Unpacking the instrument
1 Remove the FiberXpert OTDR 5000 and its accessories from the packing case.
2 Check that the module and accessories ordered are all there.
If any part is missing or damaged please contact your local PSIBER DATA agent. The FiberXpert OTDR 5000 is 
delivered as standard with:

Table 1        Elements delivered on standard with the FiberXpert OTDR 5000

A Getting Started Manual

A Li-Polymer battery, set into the equipment and which must be charged before use

A mains adapter used for mains operation of the instrument and battery charging

5 country adaptable plugs (Europe / UK / US / Australia / Japan) A hands-free soft case for the 
FiberXpert OTDR 5000

A USB cable, to directly connect the FiberXpert OTDR 5000 to a PC

A shoulder strap

About the FiberXpert OTDR 5000

The architecture of the FiberXpert OTDR 5000 is made of one Platform, to which a module is added to perform tests 
on fiber networks.

The module is fitted to the FiberXpert OTDR 5000
The FiberXpert OTDR 5000 employs multi-tasking for the simultaneous performance of several operations:

–    acquisitions
–    modifications of parameters
–    trace analysis
–    report management

It also allows to use simultaneously several functions:

–    Power Meter
–    Scope
–    OTDR measurements...

FIBERXPERT OTDR 5000 OVERVIEW1
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Main features
The FiberXpert OTDR 5000 is equipped with the following elements:

–    A 5 inch TFT color touchscreen, high visibility
–    RJ45 plug for Ethernet interface
–    Two USB 2.0 host connectors for Microscope, USB memory stick, mouse, keyboard...
–    One mini USB 2.0 device connector to connect the FiberXpert OTDR 5000 to a PC
–    An audio jack to connect a headset
–    A connection socket for the mains adapter providing the 12 V power supply and used to charge  
 the battery.
–    LED indicators for Charge, On status and Test
–    A Li-Polymer battery
–    A module interchangeable in the field: OTDR, OLP, or C-OSA.

With the FiberXpert OTDR 5000, the user can:

–    Open and/or transfer files to a PC via a USB memory stick, USB cable
–    Generate pdf reports
–    Open all user documentations included into the FiberXpert OTDR 5000
–    Update the FiberXpert OTDR 5000 firmware
–    Remote the screen of the FiberXpert OTDR 5000 onto a PC and issue commands from the keyboard 
 of the PC
–    ...
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Fig. 1            FiberXpert OTDR 5000 with module

Fig. 2            FiberXpert OTDR 5000: Front view

Fig. 3            FiberXpert OTDR 5000: Connectors View

TFT 5’’ Color
Touchscreen

Indicators

Hard keys

RJ45 USB host Mini USB 
Device

Power Meter AC/DC 
Input

VFl Headset 
jack

loudspeaker
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Hard keys and Indicators
Front panel hard keys  

Fig. 4            Hard keys and Indicators

Table 2        Hard keys description

Hard key Function

Main on/off switch

This button calls up the file explorer. It allows to:
–    choose the storage medium: internal memory, USB memory key.
–    manage files; with facilities for classifying them in directories and sub-directories.

Gives access to:
–    selection of the different measurement or functions
–    the settings of the instrument
–    the help page

This button calls up the measurement configuration menu. This menu depends on the  
function in use.

This button allows to deselect a function or escape a menu

Starts and stops the measurement.

This button calls up the results page (with OTDR module: reflectometry trace and table of 
results).

The direction keys have two principal functions:

–    on the Results page, they are used to move the cursors or modify the zoom factor.
–    on the set-up pages, they are used to scroll through the menus, the central button serving to 
select or confirm the parameter chosen.
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Front panel indicators

The FiberXpert OTDR 5000 is equipped with three indicators, lit into a different color according to the status of the 
unit.

Table 3        Indicators Status

On indicator

Blinking green The instrument, though connected to an external power source, is 
switched off.

Solid green The instrument is operating, either by battery or on an external power 
supply.

Charge indicator

Solid green The instrument is connected to an external power source and the 
battery is fully charged.

Solid red The instrument is connected to an external power source, and the 
battery is on charge.

Testing indicator

Solid red At least one function is in measurement phase (for example, the laser 
emission pilot for an OTDR measurement)

Power Supply
The FiberXpert OTDR 5000 may operate with

–    the Li-Polymer battery, already set into the equipment on delivery.
–    an AC adapter/charger, via a power cable on which has been set the correct country 
      adaptable plug.

Power supply plug

Interchangeable plugs

Fig. 5            Delivered elements for FiberXpert OTDR 5000 supplying

UK adaptable plug
(installed by default)

EUROPE
adaptable plug

US
adaptable plug

JAPAn
adaptable plug

AUSTRAlIA
adaptable plug
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This chapter gives the main information on the safety conditions when using the FiberXpert OTDR 5000:

–    “Battery and AC/DC safety information” on page 10
–    “Precautions relating to optical connections” on page 10
–    “Laser Safety instructions” on page 11

Battery and AC/DC safety information
–    The Li-Polymer battery is designed for maximum safety.

In particular, each cell is provided with a safety valve to prevent exces- sive internal 
pressure in the event of overcharging or exposure to very high temperatures.

–    Battery supplied by PSIBER DATA incorporate protection means.

Do not use any mains adaptor or battery other than those supplied with the instrument, 
or supplied by PSIBER DATA as an option for this instrument.

If another adapter or battery is used, it may damage the FiberXpert OTDR 5000 itself.

Using the FiberXpert OTDR 5000 with a battery other than the one supplied by the 
manufacturer of the FiberXpert OTDR 5000 may entail risks of fire or explosion.

The battery may explode, leak or catch fire:

–    if it is exposed to high temperature or fire

–    if it is opened or dismantled.

Other basic safety precautions are as follows:

–    Do not use AC/Adapter/Charger outdoors or in wet or damp loca- tions

–    Connect the AC/Adapter/Charger to the correct mains voltage, as indicated on the 
ratings label.

–    Do not allow anything to rest on the power cord, and do not locate the product 
where people can walk on the power cord.

–    Avoid using this product during an electrical storm. There may be a remote risk of 
electric chock from lightning.

–    Do not use this product in the vicinity of a gas leak or in any explo- sive 
environment.

–    Do not attempt to service this product yourself, as opening or removing covers may 
expose you to dangerous, high voltage points and other hazards. Contact qualified 
service personnel for all service.

Precautions relating to optical connections
–    The normal operating life of an optical connector is usually of the order of a few 
hundred manipulations. It is then advisable to manip- ulate the optical connections of 
the Platform as rarely as possible.

–    The proper operation of the instrument and its accuracy of measurement are de-
pendent on the cleanliness of the environment and the optical connectors as well as 
the care taken in its manipulation.

–    The optical connectors must therefore be clean and dust-free. If the optical con-
nection is not being used, protect the connections of

FiberXpert OTDR 5000 using the protective caps.

SAFETy InFORMATIOn2



18

laser Safety instructions
The provisions contained in two standards define the safety procedures to be 
observed both by users and by manufacturers when utilizing laser products:

–    EN 60825-1: 2001 - Safety of laser products – Part 1: Classification of products, 
requirements and user guidelines.

–    FDA 21 CFR § 1040.10 - Performance standards for light-emitting products - Laser 
products.

Due to the range of possible wavelengths, power values and injection characteristics 
of a laser beam, the risks inherent in its usage vary. The laser classes form groups 
representing different safety thresholds.

laser classes
Standards EN 60825-1, Edition 1.2, 2001-08 and FDA21CFR§1040.10:

–    VFL option: Class 2.

Warning labels for the laser classes
Due to the reduced dimensions of the optical modules, it is not possible to attach the 
required warning labels to them. In line with the provisions of Article 5.1 of the  
EN 60825-1 standard, the laser class identification labels are shown below:

Reference standard En 60825-1, Edition 1.2, 2001-08 FDA21CFR§1040.10

Class 1 CLASS 1 LASER PRODUCT

Class 2 LASER RADIATION  
DO NOT STARE INTO BEAM  
CLASS 2 LASER PRODUCT

CAUTION LASER RADIATION - DO NOT 
STARE INTO BEAM  
CLASS II LASER PRODUCT

The user must take the necessary precautions concerning the optical output of the 
instrument and follow the manufacturer’s instructions.

Measurements on optical fibers are difficult to execute and the precision of the results 
obtained depends largely on the precautions taken by the user.
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This chapter describes the first steps to perform when using the FiberXpert OTDR 5000

The topics discussed in this chapter are as follows:

–    “Fitting and removing a module” on page 14
–    “Setting the adaptable plug to the mains adapter” on page 15
–    “Charging the battery” on page 16
–    “Switching the FiberXpert OTDR 5000 on and off” on page 17
–    “First start: configuring your regional settings” on page 18

Fitting and removing a module
The FiberXpert OTDR 5000 must be switched off, and if it is operating on the mains, its 
supply cable must be unplugged.

Fitting a module

1 Turn the instrument face down on the work surface.

2  Set the two notches on the module part (1a) into the two holes provided for that 
purpose on the Base (1b).

3 Make flush the 2 connections (2a & 2b), on module and base.

4 Once positioned, fix the module to the base screwing the 2 screws (3a) fixing the 
receptacle.

STARTInG UP

2000 Platform without module

2000 Platform with module installed

Captive screws fixing the module
3a

1a

1b

2a

1a

1b

2b

3a

Fig. 6            Fixing the module to the base

Removing a module

1 Unscrew the two captive fixing screws of the module completely (up to the stop).

2 Remove the two slots of the module from their housing onto the base.

3 Carefully remove the module out of its slot.

3
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Setting the adaptable plug to the mains adapter
The FiberXpert OTDR 5000 is supplied as standard with a mains adapter and 5 country 
adaptable plugs (Europe / UK / US / Australia/Japan).

To set the correct plug to the mains adapter:

1 Make flush the connector onto the mains adapter with the adaptable plug slots.

2 Push the adaptable plug until it stops.

Fig. 7            Setting the adaptable plug onto the mains adapter

1 2 3

If the adapter plug is not correctly set onto the mains adapter, the connector may be 
damaged.

Charging the battery
Connecting the mains adapter

1 Set the appropriate adaptable plug to the power supply cable, according to your 
country (see page 15).

2 At the right side of the FiberXpert OTDR 5000, lift up the power supply socket 
protector and plug in the mains adapter.

3 Connect the adapter to the mains.

The On indicator lamp starts to blink in green.

Use only the mains adapter supplied with the FiberXpert OTDR 5000. The adapter for 
some other electronic device may appear to be identical, but entails a risk of damage 
to the FiberXpert OTDR 5000.
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First use of the battery
At the delivery, the battery is already set into the Unit, but its charge level is not 
«recognized» by the equipment.

The icon  is displayed on the upper banner of the screen.

To get a valid indication of the battery, and be able to use correctly the

Platform:

1 Charge fully the battery

2 Once fully charged, discharge the battery by keeping the Unit switched on, but not 
plugged to mains.

3 The battery can then be charged, and the Unit used simultaneously.

Charging the battery
On connection to the mains:

–    if the user does not press ON, the battery will start the charge. In this case, the 
Charge indicator will be lit in red.

–    when the user presses the ON key, the instrument starts up and the battery will 
charge during use (Charge indicator in solid red).

Once the battery is fully charged, the Charge indicator is lit in solid green.

When the Charge indicator is blinking red, this mean the power supply is not 
compatible with the battery used. Charge is disabled.

It is essential to wait until charging is complete to ensure maximum independent 
operating time, which may otherwise be considerably reduced.

Battery charging time
If the battery is completely discharged, the time taken to recharge is:

–    approximately 3.5 hours, if the apparatus is not in use (Charge indi- cator solid red)

–    about 9.5 hours if the instrument is used during charging (On indi- cator lit in fix 
green, Charge indicator lit in solid red).

Battery charge level display
When the battery is installed in the instrument, a battery icon is displayed in the top 
right-hand corner of the screen. Example: 

–    if the user does not press ON, the battery will start the charge. In this case, the 
Charge indicator will be lit in red.

–    when the user presses the ON key, the instrument starts up and the battery will 
charge during use (Charge indicator in solid red).

Once the battery is fully charged, the Charge indicator is lit in solid green.

When the Charge indicator is blinking red, this mean the power supply is not 
compatible with the battery used. Charge is disabled.
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Table 4        Battery icons

Charging the battery
The battery capacity is superior to 75%

The battery capacity is set between 50% and 75%

The battery capacity is set between 25% and 50%

The battery capacity is inferior to 25%

The battery capacity is unknown. Perform a full charge/ discharge of the battery to get 
back to a valid indication. This icon may appear if battery is changed or if the bat- tery 
auto discharges at a very low level (example: if a Unit switches off as battery is empty, 
and the charge is not done during several months (= auto discharge)).

–    When the level becomes too low, the instrument emits a beep ton inform the 
user until it switches off automatically after saving the current configuration and 
measurement.

Switching the FiberXpert OTDR 5000 on and off
Switching on the FiberXpert OTDR 5000

1 Press the ON/OFF key.

If the Unit is powered to mains, the battery will charge. The On indicator pass from 
blinking to solid green.

The startup logo appears on the screen briefly, then an auto test is carried out.

The equipment is ready to be used once all the applications are installed.

nOTE 
It is possible to switch over from battery to mains operation, or vice versa, without loss 
of data.

The module cannot be swapped when the unit is ON or AC powered

In the event of an unexpected mains power cut, if there is no battery, the current 
results and configuration will not be saved. Next time the instrument is switched on, it 
will return to its initial configuration.

Switching off the FiberXpert OTDR 5000
While the FiberXpert OTDR 5000 is operating, press the ON/OFF button to switch it off.

nOTE
When the instrument is switched off using the ON/OFF button, current results and 
configuration are saved. Next time the ON/OFF key is pressed, they are recalled.

Resetting the FiberXpert OTDR 5000
If the FiberXpert OTDR 5000 freezes, prolonged pressure (about 4 s.) on the ON/ OFF 
key will reset the instrument.
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First start: configuring your regional settings
Once the FiberXpert OTDR 5000 is switched on, the first screen displayed allows to 
configure the regional settings.

Those settings will be kept in memory and automatically applied on the instrument 
each time it is restarted.

Fig. 8            Regional Settings

1 Click on Language and select the language to be used for the equipment.
2 Click on Date and enter the current date, using the numeric keypad displayed using the menu 
key Edit Number.
3 Click on Time and enter the current time, using the numeric keypad displayed using the menu 
key Edit Number.
The date and time are displayed on the upper right side of the screen.
4 Click on Date Time Format and configure the following parameters:
–    Date format: select one of the option dd/mm/yy or mm/dd/yy.
–    Time format: select one of the option 24 hour clock or 12 hour clock.
5 Click on Net Time parameter to configure the date and time according to a network.
Dynamic Mode: the time is synchronized according to the local network.
The two lines Server Name are displayed but cannot be modified.
Static Mode: in this case, the time is synchronized to the network server which is defined in the 
two following parameters.

On the parameter Address Type, select if the address of the server which will be used for 
synchronization is entered via its IP Address or via the Server Name..
If IP Address is selected, enter one or two server addresses in the following parameters. 
During synchronization, the first address will always be used, but if a fail occurs, the second 
one will be used.
If Server Name is selected, enter the name of the server, and if necessary a name for second 
server. During synchronization, the first server name will always be used, but if a fail occurs, 
the second one will be used.

During synchronization the icon   displays on the upper banner between the date and time.
6 Once all parameters have been defined, press Exit menu key to return to System Settings page.
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This chapter describes the operations for configuring the instrument. The topics discussed in this chapter are as 
follows:
–    “Displaying the System Settings screen” on page 22
–    “Defining the screen parameters of the FiberXpert OTDR 5000” on page 23
–    “Defining the Audio parameters of the FiberXpert OTDR 5000” on page 24
–    “Defining the Automatic shutdown of the FiberXpert OTDR 5000” on page 24

Displaying the System Settings screen

To display the System Settings screen, you must:
1    Press the HOME hard key to reach the Home page.

Fig. 9            Home page

2    Activate the Settings icon    to open the System Settings screen.

Fig. 10          System Settings page

nOTE
If you are in the Regional Settings page, and you press Exit, then the System Settings 
page automatically displays.

COnFIGURInG THE FIBERXPERT OTDR 50004
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Defining the screen parameters of the FiberXpert OTDR 5000
In the System Settings page, the following parameters can be defined:

Backlight
1    Click on Backlight

2    Define the backlight level of the screen, using the left and right direction keys, or 
clicking on Edit Number softkey and using the keypad displayed.

–    Min backlight level: -5

–    Max backlight level: +5

If the FiberXpert OTDR 5000 is operating on battery, it is advisable to choose a 
minimum lighting level, acceptable for the user, to keep endurance as long as possible.

Contrast
1    Click on Contrast

2    Select the type of environment into which the instrument is used:

–    Indoor: to be selected when the instrument is used inside (see

Figure 10 on page 22)

–    Outdoor: to be selected in order to optimize the readability of the screen for an 
outside use.

  

  

Fig. 11          Example of outdoor contrast

Screen Saver 
Click on Screen Save if you wish to activate a screen saver to the equip- ment, to 
extend the life of the battery, in case the FiberXpert OTDR 5000 is not used for some 
time.

Instead of the normal screen, a small animated picture of the Unit is displayed on the 
blackened screen.

To configure the screen saver:

1    Click on Delay and select the time of inactivity before the screen saver starts:  
60s, 3 min, 5 min.

The parameter No deactivates the screen saver func- tion.
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Defining the Audio parameters of the FiberXpert OTDR 5000
In the Audio box of the System Settings screen, you can configure the audio 
parameters according you are using a headset with the Unit.

1    Adjust the volume on the line Hands-free Volume using the left and right direction 
keys, or the Numeric keypad (displayed with the softkey Edit Number)

–    Min volume for Hands-free function: 0

–    Max volume for Hands-free function: 100

2    If a headset is used, adjust the volume on the line Headset Volume, using the 
left and right direction keys, or the Numeric keypad (displayed with the softkey Edit 
Number):

–    Min volume for Headset function: 0

–    Max volume for Headset function: 100

Defining the Automatic shutdown of the FiberXpert OTDR 5000
The automatic shutdown function switches off the FiberXpert OTDR 5000 automatically 
if no operation has been performed and no key actuated for a period selected from this 
menu. Work in progress is automatically saved.

The function for automatically switching off the FiberXpert OTDR 5000 is     available 
only on battery operation, to save the battery.

1    In the Utility box, click on Auto off parameter.

2    Choose a time after which the FiberXpert OTDR 5000 will be switched off 
automatically, if no action has been done for that period: 5, 10 or 30 minutes.

Select No if the FiberXpert OTDR 5000 must not be switched off, even if there is 
inactivity on the equipment.

–    Min volume for Headset function: 0

–    Max volume for Headset function: 100
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The scope function is a hot-plug feature enabled directly when inserting a PSIBER DATA microscope supplied as an 
option:

The topics discussed in this chapter are as follows:

–    “Scope feature” on page 38
–    “Installation of tips” on page 38
–    “Configuring the Microscope” on page 39
–    “Starting up with the scope” on page 43
–    “Launching a test of the connector and fiber end-face” on page 44
–    “File menu” on page 48

Scope feature
Overview  This feature enables you to verify that your optical connectors are in perfect 
shape and very clean condition.

The Digital Probe Microscope is a portable handheld microscope used to view and 
inspect both the bulkhead (female) and patch cord (male) sides of fiber connectors as 
well as other optical devices, such as transceivers.

The microscope requires an inspection tip and is connected to the Unit with a USB 2.0 
connector.

Fig. 16          Probe components

SCOPE

QuickcaptureTM button
Instantly captures (and analyzes) fiber image

Focus Control
Inspection tip

Barrel assembly 

USB 2.0 connector 6 FT COIl Cable

latch lock 
Squeeze both ends to release

Magnification Control

5
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Installation of tips
The Pass/Fail analysis function on the FiberXpert OTDR 5000 can only be used with 
certain inspection tips mounted on the microscope.

Various tips, patchcords and bulkheads types, are available

Configuring the Microscope
Scope connection

1    Plug in your PSIBER DATA scope into a USB port from the FiberXpert OTDR 5000.

2    Push the button Home

3    Validate the Scope function              .

4    Connect probe with the fiber being inspected.

You may select this option while other options are already selected.

Configuring the Scope
1    Press SETUP key to configure the test.

The following screen displays:

Fig. 17          Scope Setup

Test On the line Profile, select the Profile which will be used for the test of fiber connector:

–    SM_UPC: Pass/Fail criteria for single-mode UPC connectors from 
IEC 61300-3-35 standard.

–    SM_APC: Pass/Fail criteria for single-mode APC connectors from 
IEC 61300-3-35 standard.

–    SM_PC: Pass/Fail criteria for single-mode PC connectors from  
IEC 61300-3-35 standard.

–    MM_: Pass/Fail criteria for multimode connectors from  
IEC 61300-3-35 standard.

Profiles contain the analysis parameters by which PASS/FAIL criteria are determined.
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Once the line is selected, you can also add a new profile, clicking on the Add Button (see “Adding a new profile” 
on page 42).

Tip On the line Tip, select the tip set onto the microscope to connect fiber for inspection.

Capture button This parameter allows to select the action of the Quick Capture button onto the Scope 
(see Figure 16 on page 38):

Freeze & Test pressing the button will automatically perform a test of fiber and freeze the result

Freeze image pressing   the   button   onto   the   Scope   will automatically freeze the live image.

Auto Center This parameter allows to select if the scope image must be centered on screen (select 
Yes) or not (select No).

File The File box allows to configure the saving of scope results.

The Dir parameter is displayed in grey, and indicates the directory into which the 
results will be saved. To change the directory, press FILE hardkey and select another 
directory from the file Explorer page; then press SETUP hard key to return to Scope 
Setup page.

On the line Filenaming, use the edition keypad, which will display by clicking on the 
right arrow key, to enter a specific name for the file. You can enter manually a name 
and/or use pre-defined parameters (Fiber Id, Cable Id, Locations...).

Pre-defined parameters 
for filenaming

Fig. 18          Edition keypad for filenaming

The line below Filenaming shows the name of the file according to the parameters 
entered.

In the Logo parameter, click on right arrow key and select in the Explorer a JPG file 
which will represent the Logo displayed on the upper left part of the report

Fiber
The Fiber box allows to configure the fiber plugged to the scope.
On the line Fiber Id, use the edition keypad, which will display by clicking on the right 
arrow key, to enter a specific name for the fiber.

On the line Fiber Number, use the numeric keypad, which will display by clicking on 
the right arrow key, to enter the fiber number.

On the line Change fiber Nbr, select if the fiber number must be modified after each 
results saving:

No: the fiber number is not modified at each saving

Increment; the fiber number is automatically incremented at each results saving

Decrement: the fiber number is automatically decremented at each results saving.
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link Description
The information entered in the Link Description window concerns the editing and/or 
the modifications of the cable and fiber parameters.

Direction The direction shows if the acquisition has been made from the origin to the extremity 
(A->B) or from the extremity to the origin (B->A). Changing direction makes it possible, 
when different extremities are handled, to see the parameters of the fiber for the other 
extremity.

location A The name of the Location A of the link may be entered.

location B The name of the Location B of the link may be entered.

Company Enter the name of the company carrying out the test.

Operator Enter the name of the operator carrying out the test.

nOTE 
All parameters of the Link Description box will appear in the pdf report or jpg file 
generated from a test results page.

About page
On the Setup screen, the softkey About, on the right of the screen, allows to display 
information on scope and current test result displayed (in Full Screen mode or mosaic 
mode - see “Mosaic Mode” on page 46).

1    Press About softkey to display a page as the following one:

Fig. 19          Microscope: About page

 

Information on scope used

Information on active 
snapshot
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Starting up with the scope
Once the FiberScope icon is validated:

1    Press RESULTS hard key

Fig. 20          Example of the result using the microscope

Use the Focus Control button onto the microscope (see Figure 16 on page 38) to adjust 
the image quality and sharpness.

NOTE 
To switch from Scope page to FO results page and vice-versa, press the RESULTS 
hard key for about 2 seconds (a beep is emitted).

Freeze mode
Once the image is acceptable, you may freeze the picture. This feature allows to store 
in memory the resulting picture.

Freezing a scope result does not store the picture in a file (see “File menu” on page 
48). The result will be lost if the instrument is shut off, or if more than 3 pictures are 
frozen (see “Mosaic Mode” on page 46)

NOTE 
The button set on the lead, or the QuickCapture™ on the microscope allows to freeze 
the picture or to take a snapshot.

High Mag. / low Mag.
The High Mag./Low Mag. menu key allows to switch the display from High to Low 
magnification and vice-versa.

This function is also available pressing the button directly on the microscope (see 
Figure 16 on page 38).

Camera mode
If you are in Freeze mode, or in Mosaic mode, with a picture selected (see “Mosaic 
Mode” on page 59), press Camera menu key to return to live camera picture.

Use the focus control to adjust the focus of the image

Sharpness level
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launching a test of the connector and fiber end-face
launching a test of the connector and fiber end-face

Once the display is correctly adjusted (magnification, sharpness...), a test of fiber 
connector can be launched.

To launch the test:

1    Press Test key to launch the test of plugged fiber connector.

The test is completed:

–    once the LED Testing is no more lit in red

–    once the icon is no more displayed on the upper banner

–    once a screen as the following one displays:

NOTE 
To configure Pass/Fail criteria, see “Configuring the Scope” page 39.

Profile selected
in the Setup page

Summary of  
Test results

Test result in
High mag.

Fig. 21          Test results

Zone A
Zone B
Zone C
Zone D

A summary of test results is displayed on the right, upper part of the screen.

–    Zone A: Core zone: it is the area

surrounding the core

–    Zone B: Cladding zone. It surrounds the majority of the fiber cladding.

–    Zone C: Epoxy ring.

–    Zone D: Ferrule/Contact zone: it identi- fies a portion of the ferrule near and around 
the fiber

NOTE 
To return to a Live Camera image, press the Camera key; or press the Full Screen/
Mosaic key view both the live image and a test result simultaneously.

In Mosaic mode (see “Mosaic Mode” page 46), the result of the test only displays Pass 
or Fail information; the status of each zone is dis- played only in full screen mode.
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Overlay
The Overlay key allows, when selected, to display the limits of each zone and to 
display with colors the defaults on the image.

When the key is deselected, the zones and defaults are not graphically identified.

This function is also available in Mosaic Mode (see “Mosaic Mode” on page 46).

Mosaic Mode
It is possible to display only one picture in full screen (640 * 390 pixels) or up to four 
pictures (320*180 pixels each, including the live camera picture) in mosaic mode. Use 
the key Full scr./Mosaic to switch from one mode to another.

Fig. 22          Mosaic mode

–    You may select one of the pictures by clicking on it.

The selected picture is framed in green.

The tool bar on the right varies according to which picture is selected (camera, or 
static picture):

Picture selected: Camera
Test Allows to launch a (new) test of the connector (see “Launching a test of the connector 

and fiber end-face” on page 44)

Freeze The live picture from the camera is frozen but does not replace the live picture at 
position 1. The  new snapshot is  placed at  the  second position, and all existing 
pictures are pushed to the next position.

If all positions were taken, the picture that was once at the fourth posi- tion is 
unloaded from memory. Frozen pictures and snapshots are lost, unless they were 
saved on the internal memory.

Position 1 :
lIVE CAMERA

Selected picture

Position 2:
File saved on disk
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High mag./low mag.
allows to modify the live display from high to low magnification and vice-versa
Picture selected: Image

Comment
allows  to  add  a  comment  to  the  selected picture (see “Adding a comment” on 
page 47)

Save
allows  to  save  the  selected  picture  in  the directory Scope, in the disk of  the Unit. 
Press Save key, enter a name for the jpg file and validate. This key is not available with 
jpg files other than those resulting from scope application.

Overlay
allows to display or hide the limits of each zone and the defaults on image from a test 
result (see “Overlay” on page 45).

High mag./low mag.
allows to switch all the images from scope test results from high to low magnification 
and vice- versa.

Adding a comment
The key Comment allows you to enter/modify a comment to your picture if necessary. 
This comment appears at the bottom left of the picture.

The right bottom of the frozen picture also contains the date of the acqui- sition (where 
the picture was frozen).

NOTE 
Both the comment and the date will be saved with the picture.

loading a picture
It is possible to retrieve and load a picture stored in the Scope directory and display it 
in the Scope page.

1    Press the FILE button.

2    Press Explorer.

3    Select the JPEG file to be loaded via the Explorer

4    Click on Load

Recognized pictures are images resulting from the Scope option and saved on disk via 
the FiberXpert OTDR 5000.

Some pictures resulting from the Scope option may appear nevertheless 
unrecognized, if they have been stored with a different Scope application, or if the JPG 
file has been opened and modified under another JPG editor.

Even though the JPG editor of the Scope function has been designed to display Scope 
pictures in black & white, it is also possible to open any JPG valid file and display in 
color the corresponding picture. That picture is enlarged or shrunk to the size of the 
display (full screen or mosaic, see.”Mosaic Mode” page 46).
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File menu
Saving the test result in a jpg file

Once the test has been performed, and the result is displayed on the
FiberXpert OTDR 5000 screen:

1    Press FILE key

2    Click on Save key to save a jpg file of the test result on the disk of the FiberXpert 
OTDR 5000.

3    On the edition keypad, enter the name of the jpg file

4    Press Enter to validate.

The file is automatically saved on the disk, in the directory Scope
(icon ).

Generating a report
1    Check the correct test result is selected (framed in green in mosaic mode).

2    Press the FILE button, then the Report key

3    On the edition keypad, enter the name of the pdf file and press ENTER.

The report generation is completed once the icon   is no more displayed on the upper 
banner.

NOTE 
The pdf report will be saved on the disk, in the directory Scope.

Display of the report
Once the report has been generated:

1    Press FILE hard key.

2    On the right menu keys, press Explorer soft key.

3    In the File Explorer, select the pdf report just created.

4    Press Load.

logo, company & parameters 
selected in the Setup page  
(see “Configuring the Scope”  
on page 39)

Fig. 23           
PDF report of Scope test result
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The FiberXpert OTDR 5000 can be used in combination with a PC in order to transfer the Unit Interface onto a PC, or 
to access the internal memory or USB memory stick contents on the PC.

Topics described in this chapter are as follows:

–    “Establishing connection” on page 52
–    “Transferring the Interface” on page 54
–    “Virtual control buttons bar” on page 55
–    “Equivalence between the keyboard and FiberXpert OTDR 5000” on page 56

Establishing connection
The connection between FiberXpert OTDR 5000 and the PC can be done directly, or via 
a local network.

The transfer of the interface can be done using a VNC window on PC.

For an intensive use of the deport screen or when it is used via a WAN network, it is 
strongly recommended to use a dedicated VNC client. The VNC clients recommended 
are Tight VNC (V 1.2.9 or later) and Real VNC (V 4.1.1 or later).

Connecting the FiberXpert OTDR 5000 and the PC
1    Connect the FiberXpert OTDR 5000 to the PC via an Ethernet cable, using the RJ45 
connectors set on both equipments.

2    Check the network connection on the PC is set in Dynamic mode.

Fig. 24          Connection FiberXpert OTDR 5000 and PC

TRAnSFERRInG THE FIBERXPERT OTDR 5000 InTERFACE6
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Configuring the FiberXpert OTDR 5000
1    In the Home page of the FiberXpert OTDR 5000, validate the Settings icon.

2    In the System Settings page, in the I/O Interfaces box, configure the following 
parameters:

Remote Screen
Remote screen = Session or Permanent must be confirmed in both cases, in the 
Interface E/S window.

no
the screen cannot be remote on to a PC or on to another FiberXpert OTDR 5000.

Session Mode
the  Remote  screen  function  is  inactive once the FiberXpert OTDR 5000 is switched 
off.

Permanent Mode
the Remote screen function is still active when the FiberXpert OTDR 5000 is switched 
off and restarted.

Permanent with password

same function as the Permanent mode, with an access to the equipment via VNC 
protected by a password: 42000

The password to access VNC can be modified:

1    Click on the menu key Change password.

2    Enter the current password in the Edition keypad and press Enter to validate.

3    Enter the new password and press Enter to validate.

Ethernet > Mode
Parameters of the local Ethernet network to which the FiberXpert OTDR 5000 is 
connected:

Config 1 to 4
static mode enabling input of the configuration of 4 sites. If this parameter is selected, 
the following parameters must be entered:

– Site Name     the user can enter the name of the site in the Edit menu.

– IP Address IP address of the FiberXpert OTDR 5000

– IP Mask address of the mask of the sub-network

– IP Gateway IP address of the machine enabling access outside the sub-network.

– DNS1 IP address of the machine providing the IP address on the basis of the name

– Domain name name of the local network to which the 2000 Platform is connected.

Dynamic
in this mode, which requires a DHCP server, the FiberXpert OTDR 5000 requests 
an IP address from this server which will be allocated dynamically if dynamic host 
configuration is activated on the local network.

After selecting this mode or after power-on, the FiberXpert OTDR 5000 tries to 
establish a connection to obtain an address from a DHCP server. If for any reason, this 
process fails, the FiberXpert OTDR 5000 reverses to static IP address mode with User1 
IP address.
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NOTE 
Once the FiberXpert OTDR 5000 is connected to the network, the icon indicates the 
connection is working.

Proxy > Use proxy
1    Select No if no proxy is used.

2    If Manual has been selected, enter the Proxy Address.

3    If Auto has been selected, enter the Pac Address.

note the FiberXpert OTDR 5000
IP Address

Fig. 25          Example of configuration for I/O Interfaces box

4    Note the IP Address displayed in the System Settings page.

5    Wait about 10 seconds the connection is established.

The FiberXpert OTDR 5000 Interface can now be transferred onto the PC, or the 
internal memory or USB key contents can be transferred on PC.

Transferring the Interface
Once the connection is established between the FiberXpert OTDR 5000 and the PC, 
proceed as follow:

1    Open your browser on the PC.

2    Considering 10.33.18.93 is the IP Address of the FiberXpert OTDR 5000 (as 
shown Figure 25 on page 54), enter the following address in the browser window: 
http://10.33.18.93:5800

3    Press Enter to validate. A VNC window opens, demanding a password

4    Press OK without typing any password. The screen of the FiberXpert OTDR 5000 
appears offset on your PC.

Fig. 26          VnC window

Click to install TightVnC 
software on your PC  

(not mandatory)
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You can use keyboard mouse of the PC to control the FiberXpert OTDR 5000 (see 
“Equivalence between the keyboard and FiberXpert OTDR 5000” on page 56).

NOTE 
Once Remote screen is accessible via VNC, the icon    displays on the upper 
banner of the screen until the connection is cut or the FiberXpert OTDR 5000 is 
switched off.

Virtual control buttons bar
It is possible to emulate hard keys with Virtual Control buttons. This virtual control 
buttons bar is especially useful when the FiberXpert OTDR 5000 screen is exported on 
a remote PC.

To display those buttons, click once on the top of the screen in the status bar, at the 
same height than the date and time.

Fig. 27          Virtual control buttons bar

The virtual control buttons bar is displayed during a few seconds. You may click on 
any of these buttons to obtain exactly the same results than using the hard keys on the 
front panel of the FiberXpert OTDR 5000.

Equivalence between the keyboard and FiberXpert OTDR 5000
The PC keyboard can replaced all the buttons and keys of the FiberXpert OTDR 5000 
except the ON/OFF button:

–    The menu keys to the right of the screen are replaced by the function keys F1 to F6.

–    The buttons below the screen are equivalent to Ctrl + a letter (see table below).

–    The direction keys have the same function on the external keyboard and on the 
FiberXpert OTDR 5000.

Function on the FiberXpert OTDR 5000 External keyboard
HOME Ctrl + H
SYSTEM SETTINGS F12
SET-UP Ctrl + U
FILE Ctrl + F
RESULTS Ctrl + R
START/STOP Ctrl + S
EXPORT Ctrl + Pa
Menu keys 1 to 6 (from top to bottom) F1 - F6
ABOUT F11
Save and quit (Exit) Entrée/Enter
Quit without saving (Abort) Escape/Echap.

a. The Export function is available directly on the FiberXpert OTDR 5000 pushing 
simultaneously the left and right arrow keys.
NOTE 
Those equivalences are also valid with a keyboard directly connected to the 
FiberXpert OTDR 5000 via one USB port.
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The FiberXpert OTDR 5000 allows to access to internet, using the Web Browser installed on the equipment.

The topics discussed in this chapter are as follows:
–    “Configuring the Web access” on page 62
–    “Starting the web browser” on page 62
–    “Creating bookmarks” on page 64
–    “Opening a PDF document” on page 64
–    “Leaving the web browser” on page 65

Configuring the Web access
Before using the Web Browser on the FiberXpert OTDR 5000, check/modify the proxy 
configuration in the System Settings page:

1    On the Home page, press Settings key. The System Settings page displays.

2    Select Proxy parameter in the I/O Interfaces box to open a sub- menu.

Fig. 31          Proxy configuration

3    Configure the parameter User Proxy

–    If Manual is selected, enter the Proxy Address with edition keypad

–    If Auto is selected, enter the Pac Address using the edition keypad.

Starting the web browser

1    In the Home screen, select Web Browser  icon.

The web browser is launched.

Fig. 32          Web Browser page

WEB BROWSER7
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Opening an internet page
Before using the Web Browser on the FiberXpert OTDR 5000, check/modify the proxy 
configuration in the System Settings page:

1    On the Home page, press Settings key. The System Settings page displays.

2    Select Proxy parameter in the I/O Interfaces box to open a sub- menu.

Once the Web Browser is displayed, you must enter the internet address.

1    Set the cursor in the address bar: 
a    Use the mouse connected via USB port on the FiberXpert OTDR 5000 or the 
mouse of the PC if the screen is deported via VNC application on the PC, or use the 
touchscreen. 
b    Click on the menu key so that it becomes. This allows to move the cursor toward 
the address bar.

2    Once the cursor set onto the address bar, enter the address: 
a    Using a keyboard connected to the FiberXpert OTDR 5000 USB port or the keyboard 
of the PC with a deport of the 
screen via VNC, enter the entire address of the site to be opened. 
b    If none keyboard is available: 
–    click on the menu key  to display the virtual keyboard and enter the address using 
the buttons on the FiberXpert OTDR 5000 or clicking directly on characters.

3    Push the ENTER hard key. 
The page opens 
If an error message is displayed in place of the internet page, verify the address you 
typed, or check the configuration (see “Configuring the Web access” on page 62).

Fig. 33          Internet page opened with the Web Browser
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navigation into the Web Browser

Once the Web Browser is open, press the key     to display on the right of the 
screen, the buttons used to navigate.

Icon Definition

Go to the previous or next page loaded

Refresh the actual page

Exit the Navigation menu

When a link is available, the arrow cursor becomes a hand cursor

Creating bookmarks
Once a page is opened, you can apply it a bookmark, in order to get a shortcut toward 
this page.

Once the internet page for which a bookmark must be created is opened:

1    Click on    to open the dialog box for bookmarks creation..
A new tools bar is displayed on the right of the screen.

2    Click on menu key   to add a bookmark for the page displayed

3    Click on  to edit the bookmark, and modify if necessary the name of 
the bookmark. Click on Ok to confirm the modification or Cancel to cancel the 
modifications.

Fig. 34          Bookmark edition

– Click on  to open the page of the bookmark selected in the list

– Click on  to delete the selected bookmark from the list

– Click on  to exit bookmark menu and go back to Web Browser.
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Opening a PDF document
PDF documents may be opened and read within the Web browser.

1    When you click on a link toward a PDF file, a dialog box during loading is displayed.

2    Once loading is completed, click on Ok to open the pdf file.

Fig. 35          Downloading a pdf file

Click on the menu key    to go back to the web browser.

NOTE 
The web browser will open a PDF document, not a URL including a PDF file.

The PDF is also automatically saved on the disk of the Platform.

leaving the web browser
Depending on how long you want to leave the web browser and on your connection 
mode, you may:

–    Leave the web browser running and switch to another task. To do this, click on the 
HOME button.

The web application is still running in the background. Nevertheless, you have now a 
complete access to all the FiberXpert OTDR 5000 functionalities.

To go back, you must select again the Web Browser in the Home page. The application 
will reopen much faster, and all your environ- ment will be the same (last current page, 
possibilities to go back...)

–    Quit the application using the Web browser application menu: click on the key.
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The files management with the FiberXpert OTDR 5000 can be performed, whether a module is set onto the FiberXpert 
OTDR 5000 or not.

The topics discussed in this chapter are as follows:

–    “File Explorer Overview” on page 68
–    “Directories and Files selections” on page 68
–    “Directories & Files editing functions” on page 69
–    “Working with directories and files from the explorer” on page 70
–    “Creating a screenshot” on page 79
–    “Creating a report” on page 80
–    “Merging pdf or txt files” on page 82
–    “Storage media” on page 84

File Explorer Overview
To reach the File Explorer page

–    On the Home page, select the File Explorer icon. The File Explorer page appears.

Fig. 36          File Explorer page

Directories and Files selections
Directory selection

To select a directory from the explorer page:

1    Press on the directory that must be selected on the left of the screen.
The list of files the directory contains displays on the right side of the screen
The selected directory is underlined in blue

2    Click on the arrow at the left of the directory name, or press valida- tion hard key, 
 to display the sub-directories if any.

The file is automatically saved on the disk, in the directory Scope (icon ).

FIlE MAnAGEMEnT8
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Fig. 37          Directory selection

Files selection  To select one or several files from the explorer page:
1    Press on files that must be selected. or

To select a list of files using the keys of the Unit:

a    Select and validate the first file of the list (underlined in red)

b   Set the cursor on the last file of the list (underlined in blue)

c    Maintain the right direction key      pushed until all the files are selected.  
Or click on Select all menu key to select all files into the directory.

NOTE 
The last selected file is underlined in red and the previous one(s) selected is/are 
underlined in blue.

Fig. 38          Example of files selection

Directories & Files editing functions
Copy/Cut & Paste files/ directories

To copy (cut) one or several files, or one directory, and paste them in another place:

1    Select the directory / the file(s) (see “Directories and Files selec- tions”  
on page 68).

2    Press Edit menu key

3    Press Copy to keep the directory / file(s) to their initial location. Or
Press Cut to delete the directory / file(s) from their initial location

4    On the left of the screen, select the directory; or select the new storage media.

5    Click on Paste menu key.

Access to sub-directory Selected directory

Sub-directory

Selected files

Selected directory
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Renaming a directory / file
1    Select the directory / file to be renamed (see “Directories and Files selections”  
on page 68).

2    Press Edit > Rename Directory or Rename File.

The Edition keypad displays.

Fig. 39          Edition keypad for renaming file

3    Press Clear if you wish to delete the entire name

4    Enter a new name for the directory / file.

5    Click on Enter to validate the new name.

Deleting a directory / file
1    Select the directory or file(s) to be deleted (see “Directories and
Files selections” on page 68).

2    Press Edit > Delete.
A confirmation dialog box displays.

3    Press Yes to delete the selected directory or file(s).
Press No to cancel the deletion.

Working with directories and files from the explorer
Creating a directory

To create a new directory from the explorer page:

1    Check the cursor is set on the left of the screen

2    Select the storage media into which the directory must be created

3    If you want to create a sub-directory, select the directory into which it must be 
created.

4    Press the right menu key Create Directory.

The edition keypad displays

5    Enter a name for this directory

6    Press Enter key to validate the new directory
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Opening files
Once a file is selected, press Load menu key.

Opening several files at the same time can be done exclusively with trace files 
(example: all OTDR trace files if a reference trace has been defined). Other type of files 
(PDF, TXT...) must be open one by one.

If different types of files have been selected in the Explorer, only the last one selected 
will open.

File Types
For files recognized by the FiberXpert OTDR 5000, the types are symbolized by icons. 
E.g.

Icon Type of FO file

OTDR file (.SOR extension)

Multi OTDR file (.MSOR extension) 

Power Meter file (.LTS extension)

HTML file (.HTML extension)             

PDF File (.PDF extension)

Text file (.TXT extension)

License file (.LIC extension)

CSV file (.CSV extension)

JPEG / JPG file (.JPEG extension)

PNG file (.PNG extension)

XML file (.XML extension)

With the FiberXpert OTDR 5000, you can open and load any kind of FO files (OTDR, LTS) 
even if the corresponding module is not set into the Unit.

Sorting files
Whether files are selected or not, the key Sort allows to access to a sub-menu 
allowing to sort the file according to pre-defined parameters:

–    Sort by name: the files display in an ascending order (from A to Z). If you click once 
again on the key, the files display in a descending order (from Z to A).

–    Sort by size: by clicking once on this key, the files display from the smallest to the 
heaviest one. Clicking a second time allows to sort the files in opposite order.

–    Sort by type: clicking once on this key; the FiberXpert OTDR 5000 displays files in an 
ascending order (the file type A to file type W). By clicking again, the FiberXpert OTDR 
5000 displays the files in opposite order.
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–    Sort by date: clicking once on this key; the FiberXpert OTDR 5000 displays files from 
the more recent to the less one. By clicking again on key, the Unit displays files from 
the older to the more recent one.

NOTE 
You can also sort files clicking on the column titles in the files list

Transferring files between two Units
If some Results traces or other kinds of file need to be transferred to another Unit, or 
if files from another Unit must be transferred to the FiberXpert OTDR 5000, this can be 
easily done using a USB cable.

Establishing connection between two Units
1    Connect the FiberXpert OTDR 5000 to another one, plugging the USB cable on the 
mini USB port of the Unit toward a USB port on the other Unit.

Fig. 40          Direct connection FiberXpert OTDR 5000 <-> FiberXpert OTDR 5000

2    Once connection is established, confirm that you wish to activate the USB link in 
the pop-up window on the FiberXpert OTDR 5000.

Fig. 41          Confirmation of files export via USB cable

USB port on the Unit

USB cable

Mini USB Port on the 
FiberXpert OTDR 5000
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Transferring files
1    On the distant Unit, open the File Explorer page
The usbflash driver appears  on the left side of the screen.

2    Select the file(s) to be transferred from one Unit.

3    Press Edit > Copy or Cut softkeys.

4    Select on the left of the screen, the directory on the other Unit, into which file(s) 
must be transferred.

5    Press Paste softkey.
File(s) is/are transferred.

Cancelling the connection
Once all desired files have been transferred, connection between both FiberXpert 
OTDR 5000s can be removed:

1    On the distant Unit, press Eject USB key before removing USB plug from connector.

2    On the FiberXpert OTDR 5000, remove the mini USB plug from its connector.

The screen displays the results trace of the active function, or returns to the Home 
page if no function is active.

Transferring files to a PC with the USB cable
If some Results traces or other kinds of file need to be transferred to the PC, this can 
be easily done using a USB cable.

Establishing connection 2000 Platform <-> PC
1    Connect the FiberXpert OTDR 5000 to a PC, plugging the USB cable on the mini USB 
port of the Unit toward a USB port on the PC.

Fig. 42          Direct connection FiberXpert OTDR 5000 <-> PC

2    Once connection is established, confirm that you wish to activate the USB link in 
the pop-up window on the FiberXpert OTDR 5000.

USB port on the PC
Mini USB Port on
the 2000 Platform
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Fig. 43          Confirmation of files export via USB cable

A message displays on the bottom right side of the PC informing a new hardware is 
detected.

3    Click on the message and select «Open folder to view files» in the dialog box 
PSIBER DATA DISK (F:) («F:» is an example, it can be different according to your PC 
and to the USB port used).

Fig. 44          Open FiberXpert OTDR 5000 disk content

The FiberXpert OTDR 5000 disk content opens onto the PC.



51

Transferring files onto the PC
1    Select the file(s) from the FiberXpert OTDR 5000 to be transferred  
onto the PC

Fig. 45          Files selection from the FiberXpert OTDR 5000

2    Press Ctrl + C, or right click and select Copy.

3    On the PC, select the directory in which file(s) will be transferred.

4    Press Ctrl + V, or right click and select Paste.

Cancelling the connection
Once all desired files have been transferred onto the PC, connection between 
FiberXpert OTDR 5000 and PC can be removed:

1    On the PC, use the appropriate method to safely remove the USB cable from the 
USB port.
The screen displays the results trace of the active function, or returns to the Home 
page if no function is active.

2    Remove the mini USB plug from the FiberXpert OTDR 5000 USB port.

Transferring files to/from a PC with a FTP server
It is possible, from a PC, to access the internal memory of the FiberXpert OTDR 5000 
or to the USB memory stick connected to the Unit by means of the FTP server of the 
FiberXpert OTDR 5000.

1    On the PC, use the appropriate method to safely remove the USB cable from the 
USB port.
The screen displays the results trace of the active function, or returns to the Home 
page if no function is active.
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Direct connection   
1    Connect directly the FiberXpert OTDR 5000 Unit to the PC with an Ethernet cable, 
using the RJ45 connectors on each equipment.

Fig. 46          Ethernet Connection FiberXpert OTDR 5000 <-> PC

2    Make sure the network configuration onto the PC is set to the Dynamic mode:

a    Click on Start > Control Panel.

b   Double click on Network Connection.

c    Double click on Local Area Connection.

d   In the dialog box, click on Properties.

e    Check the parameter Internet Protocol (TCP/IP) is selected
( ) and click once on it (underlined in blue)

f    Click on Properties button.

g   On the tab General, check the parameter Obtain an IP address automatically is 
selected ( ); if not, click to select it.

Fig. 47          Internet Protocol

h   Click on Ok and close all the dialog boxes opened onto the PC.
3    On the FiberXpert OTDR 5000 Unit, in the System Setup page, under I/O inter- face > 
Ethernet, select Dynamic.

Fig. 48          System Setup > Ethernet: Dynamic mode

IP Address  
of the Unit
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4    Note the IP Address and wait for about ten seconds while the connection is 
established.

Connection via a local network
1    On the PC: find the IP address and the mask of the PC’s sub- network:

–    With Windows NT, 2000, XP, Vista or 8: select Start > Programs > Accessories > 
Dos Prompt, type ipconfig”, then Enter.

Note the IP address and the mask of the PC’s sub-network.

2    Plug the RJ 45 connector of the FiberXpert OTDR 5000 into a hub or Ethernet switch 
with a straight-through Ethernet cable (see Figure 42 on page 74).

3    On the FiberXpert OTDR 5000:

In the system set-up menu, under I/O interfaces > Ethernet, select Config 1 (or 2 / 3 / 4) 
on the line Mode, then enter the IP address, the IP mask of the PC and the IP gateway 
previously noted (step 1). or use Dynamic attribution mode (DHCP). In this case, the 
address of the FiberXpert OTDR 5000 (10.33.18.235 in the example) is displayed but 
cannot be altered.

4    Wait for about ten seconds while the connection is established.

5    On the PC, make sure that the connection is operational by selecting Start > 
Execute... and typing ping followed by the address of the FiberXpert OTDR 5000.

Accessing the internal memory of the FiberXpert OTDR 5000
FTP access is obtained through the user account «fiberxpert5000»  
(password: PSIBER).

1    Make the FiberXpert OTDR 5000 / PC connection as described Figure 46 on page 76.

2    On the PC, use an FTP client, and access to internal memory via an internet 
explorer (I.E, Mozilla Firefox...) or Windows Explorer.

3    In the address bar, type the following address (10.33.18.235, being the IP address of 
the FiberXpert OTDR 5000 defined when the connection was configured; see Figure 48 
on page 77):
ftp://fiberxpert5000:PSIBER@10.33.18.235/disk/
This allows to access to internal memory.
ftp://fiberxpert5000:PSIBER@10.33.18.235/usbflash/
This allows to access to the contents of the USB memory stick connected to the 
FiberXpert OTDR 5000.

If you use Internet Explorer 7, the following address must be entered:

ftp://mts2000:PSIBER DATA@10.33.18.235/acterna/user/disk or

ftp://mts2000:PSIBER DATA@10.33.18.235/acterna/user/usbflash

The PC then displays the contents of the internal memory or of the USB memory stick 
from the FiberXpert OTDR 5000.
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Fig. 49          Internal memory of the FiberXpert OTDR 5000

4    If internal memory of the Unit is accessible via Internet Explorer (or any other 
explorer), right click on one file and click on Save target as... to transfer file onto the PC.
If internal memory of the Unit is accessible via Windows Explorer, select one / several 
files and click on Copy, then click on Paste on PC to transfer file.

Creating a screenshot
You can create captures of what is displayed on the screen, directly from the 
FiberXpert OTDR 5000.

Configuring the parameters of screenshots
To configure the screenshot and choose the format of the generated file:

1    Press HOME hard key

2    Select the Settings icon to reach the System Settings page.

3    In the Report box, on the line Mode, select Screenshot
Choosing this option, you can save the displayed screen in JPG, PNG or PDF format, 
exactly as it is displayed on the screen.
Therefore, if you make a zoom on the trace for example, the file will only show the 
zoom section.

4    On the line File format, select if the printed file will be a JPG, PNG
or PDF file.

Taking a screenshot
Once the screenshot parameters are configured:

1    Reach the display which will be saved as a screenshot in a file.

2    If necessary, make modifications on this display (example: zoom on trace...)

3    Press simultaneously the left and right arrow keys  for about
5 seconds or Click on the upper banner of the screen and, in the virtual control buttons 
bar, press Export key. The icon  displays until the end of process.

4    Press the FILE key to find the JPG, PNG or PDF file in the Explorer

Internal memory open via Internet Explorer Internal memory open via Windows Explorer
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name of the screenshots files
The screenshot is saved in a file, which is automatically named as follow:

–    Print_date (year/month/day)_time (hour/minute/second).jpg/png/pdf

Fig. 50          Example of screenshot, open in the Web Browser of the FiberXpert OTDR 5000

The file is saved in the directory Fiberxpert, on the storage media disk.

Creating a report
Once the results page of a function is opened (example: OTDR trace, Power Meter 
results...), it can be exported in a report, using the FiberXpert OTDR 5000 Unit.

Configuring the report
To configure the report and choose the format of the report file:

1    Press HOME hard key

2    Select Settings icon to reach the System Settings page.

3    In the Report box, on the line Mode, select Report.
Choosing this option, you can save the open file in a JPG, PNG or PDF file report, 
exactly as if the file was printed on paper.
Therefore, if the file is too large for one A4 page, several JPG, PNG or PDF files will be 
created.

4    On the line File format, select if the report file will be a JPG, PNG or PDF file.

5    To display a Logo on the upper right of the report pages, click on Logo line and 
select the Logo to be displayed on the upper right of the page:
a    Press   to open the edition keypad
b   Enter the path of the logo file with its extension (example: disk/Psiber Data logo.jpg)
c    Press Enter to validate.

Fig. 51          Example of Report configuration
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Creating the report
1    Open the file to be saved in a report in JPG, PNG or PDF format

2    If necessary, make the modifications on the file/trace (see user manual part of the 
OTDR Modules for OTDR trace files).

3    Set the trace view as wished.

For OTDR traces
–    if the function is set to the Trace mode (Trace is selected on the menu key Trace/
Table/Summary), the JPG/PNG/PDF file will contain the header and the trace (in one 
page).
–    If the function is set to Table mode (Table is selected on the menu key Trace/Table/
Summary), the JPG/PNG/PDF file will contain the header, the trace and the entire 
results table (several pages may be required)
–    If the function is set to Summary mode (Summary is selected on the menu key 
Trace/Table/Summary), the JPG/PNG/PDF file will contain the header and the 
summary page, with either the Bend table or the Alarm Table according to the 
selected item with the menu key.
This view is only available with OTDR traces.

4    Press simultaneously the left and right arrow keys  for about 5 seconds or
Click on the upper banner of the screen and, in the virtual control buttons bar, press 
Export key
The icon   displays until the end of process.

5    Press the FILE key to find the JPG, PNG or PDF file in the Explorer

The files are saved in the directory Print, on the disk media storage.

name of the report
If a trace has been saved in a report file, the name of the JPG/PNG/PDF
file is as follow:

–    name of the stored trace_date (year/month/day)_time (hour/minute/
second).jpg/png/pdf

nOTE
If several traces are displayed in overlay, a different report file is gen- erated for each 
trace open.

Fig. 52          Example of report (in pdf)
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Merging pdf or txt files
In the Explorer page, two pdf/txt files or more, generated via the results traces can be 
merged in one pdf file.

–    The pdf files that can be merged are those generated via the Fast Report key on 
trace results page or via the Export key on the upper banner (or left and right arrow 
keys) (see “Creating a report” on page 80)
–    The txt files that can be merged are those saved with the results trace (see OTDR 
Modules User Manual Part).

1    In the Explorer, select the two or more pdf/txt files generated

2    Press Export menu key

3    Press Merge key

Fig. 53          Files selection and Merge key

The icon  is displayed during merging process.

After a few seconds, the files are merged in one pdf/txt file, which name by default is: 
merged_year_month_date    hour_min_sec.pdf

The file is automatically saved in the same directory as the one where files have been 
selected.

It gathers all results from pdf/txt files selected (and traces for pdf file), in one single 
pdf file of several pages (1 results screen per page, if the results table does not exceed 
one page).

nOTE
Once merged file is saved, it can be renamed in the Explorer  
(see “Renaming a directory / file” on page 70).

Storage media
For saving or recalling data, the FiberXpert OTDR 5000 offers a wide choice of media, 
both built-in and external.

Free space on selected media is clearly displayed at the bottom of the left panel.

Storage media built into the FiberXpert OTDR 5000
The FiberXpert OTDR 5000 is delivered with an internal memory, which maximum 
capacity is of 1GB (with a minimum of about 128 Mb are available for data storage).
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External USB storage media
The FiberXpert OTDR 5000 is equipped with 2 USB ports as standard. One of these can 
be used to connect an external storage medium, in particular a USB memory stick.

nOTE
Although two USB ports are present, it is not possible to use simulta- neously more 
than one external USB storage medium.

USB memory stick connection
1    Insert the USB memory stick in one of the FiberXpert OTDR 5000’s USB port.

A sound is emitted to confirm the successful insertion and recogni- tion of a USB 
memory stick.

Then, the icon  is displayed in the upper banner to inform the user the USB stick is 
ready to be used.

When a file is moved in the explorer of the Unit, the end of the move on the screen 
does not mean that writing of data into the memory is complete. Some data may still be 
in a writing process if the storage unit is removed prematurely.

USB memory stick disconnection
1    Before disconnecting the USB memory stick, always select a storage device 
different from usbflash (select disk for example) in the explorer.

2    Make sure you no longer have any running applications using the usbflash storage 
media.

3    The user must push the EJECT USB key, available in File Explorer.

The icon becomes  to indicate it can be removed safely. In this state, the USB stick 
cannot be used anymore.
The USB memory stick can then be disconnected from the Unit’s USB port.

nOTE
The USB memory stick can also be removed using the Expert Tools
> Media Utilities menu, accessible via the System Settings page.

See Chapter 16 “Maintenance and Troubleshooting” if any problem occurs with the 
USB memory stick

Cloud Storage
Principle and prerequisites of the Cloud Storage

The Cloud storage defined the outsourcing of data on distant servers, which avoid the 
data storage on a local workstation.

The cloud storage onto a FiberXpert OTDR 5000 allows to transfer the files from the 
Platform toward a distant server and vice-versa.

Before configuring the Cloud Storage on Platform, you must first create an account on 
a Cloud Platform on internet.

The Cloud storage function onto the FiberXpert OTDR 5000 works exclu- sively with 
sites using the WebDav technology such as CloudSafe (https://secure.cloudsafe.com/
pages/index.html) or Box (https:// www.box.com/pricing/).

Once account is created, with WevDav configuration, you get the following 
information for connection:

–    URL

–    Login Name

–    Login Password
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Configuring and connecting to Cloud Storage on the FiberXpert OTDR 5000
Configuring the FiberXpert OTDR 5000

Once an account has been created on the Cloud site, configure the FiberXpert 5000 
Unit before establishing the connection:

Before configuring the Cloud Storage, make sure the configuration for Ethernet 
parameters and Proxy parameters are correctly configured. See “Ethernet > Mode” on 
page 53 and “Proxy > Use proxy” on page 54.

1    On the Home page, press Settings to reach the System Settings page

2    In the I/O Interfaces windows, press Cloud Storage parameter A new menu opens

3    In the Url parameter, enter the URL define for the Cloud server created on internet

4    In the User parameter, enter your Login created on your account

5    In the Key / Password, enter the password attributed by the Cloud server.

Fig. 54          Example of configuration

Connecting Cloud Storage
Once configuration has been established on the FiberXpert OTDR 5000, it is ready to be 
connected with Cloud server:

Select one parameter of the Cloud Storage window on FiberXpert OTDR 5000

1    Press Connect Cloud Storage menu key. 

The connection launches

2    Once connection is established, a message displays in the window

3    Press any key to continue, and start files transfer.

The icon  is displayed on the upper banner as long as the connec- tion is active.

Configuration on FiberXpert OTDR 5000Configuration on Cloud server
(example with CloudSafe)
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Disconnecting from Cloud storage
To disconnect the FiberXpert OTDR 5000 from Cloud storage:

1    Press HOME hard key.

2    Select a parameter of the Cloud Storage window.

3    Press Disconnect Cloud Storage menu key.

Transferring files using Cloud Storage
Once connection between FiberXpert OTDR 5000 and cloud storage server is 
successfully established, the files can be transferred from one Unit to the other.

1    Press HOME hard key.

2    Press FILE Explorer on the Home page

In the Explorer page, a new storage media is available: cloud- storage.

The cloud-storage media is not available when File Explorer is opened from a  
FO application.

3    Transfer the files from the disk or USB memory stick of the FiberXpert OTDR 5000 
Unit toward the cloud storage or vice-versa:

a    Select the file(s) to be transferred

b   Press the Edit > Copy or Cut menu keys

c    Select the storage media (and the directory) into which files must be copied.

d   Press Paste menu key

Fig. 55          File Explorer with cloud storage

The cloud storage is automatically disconnected once the Unit is switched off. 
Reconnect from the System Settings page of the FiberXpert OTDR 5000 after the Unit 
restart.

Abbreviations for storage media
Abbreviation Storage medium

disk Internal flash memory

usbflash USB memory stick

cloud-storage Cloud storage media available on PC

Edition menu
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This chapter contains the technical specifications of the FiberXpert OTDR 5000 mainframe.
The topics discussed in this chapter are as follows:

–    “Display specifications” on page 120
–    “Memory” on page 120
–    “Input/Output” on page 120
–    “Power supply” on page 120
–    “Dimensions - Weight” on page 121
–    “Environment” on page 122
–    “Characteristics of the options” on page 123

Display specifications
Screen –    Backlight high visibility color touchscreen

–    Size: 5 inches

–    Resolution: 800 x 480 pixels

Memory
–    Standard memory: internal memory, with a capacity of 1GB (with a minimum of 
about 125 Mb are available for data storage).

Input/Output
–    two USB 2.0 host ports.

–    one Mini USB 2.0 device

–    one RJ 45 connector for Ethernet interface 10/100/1G

–    built-in loudspeaker + headset jack

Power supply
Battery   The instrument can be supplied with one Li-Polymer battery.

Endurance of the FiberXpert OTDR 5000 with battery

Measurement conditions:

–    at +25 °C,

–    at full battery capacity (4.5 Ah),

–    FiberXpert OTDR 5000 equipped with one OTDR module

TECHnICAl SPECIFICATIOnS9
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Mains adapters
Standard Mains Adapter

Input 100-240 V, 50-60 Hz

Output 12V DC   2.5 A max

Compliance EN 60950

Endurance
Conditions of use li-Polymer battery

According to Telcordia GR-196-CORE recommendation: 
Normal conditions, with normal backlight, 3 acquisition 
of 30 seconds per quarter of hour, auto off

up to 8 hours

Under continuous acquisition, with high screen 
backlight:
- with an OTDR QUAD Module
- with an OTDR LM Module

 
 
Up to 3h
Up to 3h45

Supply or Power assigned in AC and in DC: 25 W

Dimensions - Weight
Weight

FiberXpert OTDR 5000 without options, battery nor module 692 g 1.52 lbs

FiberXpert OTDR 5000 with a Li-Polymer battery and one
OTDR LM Module

1.21 kg 2.67 lbs

Li-Polymer battery 172 g 0.37 lbs

VFL/PWM option 30 g 0.066 lbs

Dimensions (mm) (H X W X D) 
Bumpers included

Dimensions (mm) (H X W X D)  
W/o bumpers

Without module 175 x 138 x 41 169 x 134 x 39

With 1 module 175 x 138 x 80 169 x 134 x 72

Environment
–    Operating temperature range -20°C to +50°C (-4°F to +122°F)

–    Operation including all options  
(guaranteed specifications)

0° to +40°C (+32°F to +104°F)

–    Storage -20°C to +60°C (-4°F to +140°F)

Humidity  
–    5 to 95% without condensation

EMI/ESD  
–    CE class B Compliant (EN61326-1) –    FCC 47-1 Part 15 Compliant
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Drop test 
In accordance with the Telcordia GR-196-CORE recommendations, the

FiberXpert OTDR 5000 resists the following test:

–    6 impacts dropped from a height of 1m on a pinwood floor of 5 cm thickness (1 
impact on each of its 6 sides, with power off).

Shocks 
The FiberXpert OTDR 5000 resists the following test:

–    3 shocks per axis along each of the 3 axes, with power off.

–    Impacts of 15g, 1/2 sine, duration 11 ms, at 10 second intervals.

Bumps
The FiberXpert OTDR 5000 resists the following test:

–    1,000 bumps per axis along each of the 3 axes, with power off.

–    Jolts of 15g, 1/2 sine, duration 6 ms, at 1 second intervals.

Vibration
The FiberXpert OTDR 5000 resists the following vibration tests:

–    Complete test comprising 6 cycles along each of the x, y and z axes.

–    One cycle of 5 to 200 Hz and back to 5 Hz with a sweep duration of one minute/
octave.

–    3 mm amplitude displacement test, for the range 5 Hz to 15 Hz.

–    3g acceleration test for the range 16 Hz to 200 Hz.

Flammability
The FiberXpert OTDR 5000 housing (in ABS, type V0) does not propagate fire.

Characteristics of the options
Power meter

Specifications given for 25°C, after 20 minutes stabilization time and after zero setting.

–    Wavelength range: 800 to 1650 nm in steps of 1 nm

–    Calibrated wavelengths: 850 / 1310 / 1490 / 1550 / 1625 / 1650 nm1

–    Accuracy at calibrated wavelengths: ± 0.2 dB (at -30 dBm)

–    Input power range: -60 dBm to +10 dBm

–    Maximum resolution: 0.01 dB / 0.01nW

–    Measurement range:+5 to -50 dBm (+5 to -45 dBm from 800 to 1250 nm)

–    Linearity within the measurement range: ± 0.2 dB

High power Power meter

VFl 
–    Wavelength: 650 nm

–    Length of fiber: up to 5 km

1. Specifications guaranteed to the calibrated wavelengths, except for 1650 nm

–    Class 2 laser (standards EN60825-1 and FDA21 CFR Part 1040.10).
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This chapter describes how to maintain your unit and identify and correct problems related to the  
FiberXpert OTDR 5000.
The topics discussed in this chapter are as follows:
–    “Maintenance procedure” on page 130
–    “Recycling Information” on page 144
–    “Troubleshooting” on page 144
–    “General information on warranty” on page 148

Maintenance procedure
Maintenance work on this instrument must only be undertaken by qualified personnel using suitable equipment.

In most cases, it is advisable to contact the nearest PSIBER DATA Service Centre, 
which will undertake the appropriate troubleshooting and repair work.

The performance and technical complexity of the FiberXpert OTDR 5000 class this 
instrument in a new generation of equipment, for which PSIBER DATA has laid down a 
maintenance policy based on the principle of standard module replacement.

In implementation of this policy, we have set up powerful card trouble- shooting 
test resources in our factories and a rapid dispatch system operating between our 
factories and branches.

Only by this procedure can the high quality of the instrument continue to be ensured 
after repair work. This procedure also has the advantage of reducing repair costs and 
time.

In the interests of quality and efficiency, we strongly recommend adop- tion of the 
following procedure in the event of a fault, before any other steps are taken:

–    Verify that the instrument is plugged in.

–    Check the connections of any peripheral equipment to the Unit.

–    If a fault is detected, or in case of doubt, it is advisable to contact the nearest 
PSIBER DATA Service Centre, which will undertake the appropriate repair work.

Cleaning
Cleaning plates and housings

The front and rear plates and the housings may become tarnished with handling. 
To clean them, use only a rag moistened with soapy water. Never use any product 
containing acetone, trichlorethylene, benzine or alcohol, as these will attack the 
printed markings.

Cleaning the screen
To clean the screen, use an antistatic product.

MAInTEnAnCE AnD TROUBlESHOOTInG10
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Cleaning the optical cable connector
–    Use a non-fluffy type of paper, such as Joseph paper, soaked in isopropylic 
alcohol.

–    Pay particular attention to the polished face of the fiber, rubbing it in a direction 
perpendicular to the axis of the fiber.

Cleaning the optical connections of the FiberXpert OTDR 5000
–    Squirt a highly volatile solvent (such as isopropylic alcohol) into the connector.

–    Blow out the connector using a clean dry air supply from an aerosol can fitted with 
an extension.

nOTE
If your module has a universal connector, unscrew its adaptor to access the ferule.

Accessing to the FiberXpert 5000 Unit information
On the FiberXpert OTDR 5000, some screens allow to display information on different 
elements of the equipment.

To display the information on the FiberXpert OTDR 5000

1    On the Home page, validate Settings icon to reach the System Settings page.

2    On the right menu keys, press About to display the presentation screen of the 
FiberXpert OTDR 5000.

General page
The General page is displayed by default, and allows to display the presentation 
screen, with all the information concerning the software versions, the hardware 
options and the module installed.

Fig. 88          General page

This page shows:
–    The software version information

–    The product contents: base, optical options, battery type, touch- screen used, 
module installed and date of calibration for options .

The options set into the FiberXpert OTDR 5000 are marked with a green tick.
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Software options page
This page allows to visualize the software options available on the FiberXpert OTDR 
5000 UnitPlatform.

1    Once on the About screen, press Software Options menu key to display the list of 
software options available on your FiberXpert OTDR 5000.

Fig. 89          Software Options page

Services Data page
This page allows to display information about the elements inside the FiberXpert OTDR 
5000 (CPU, Memory, hardware revision, screen reference...).

1    Once on the About screen, press Services Data menu key to display the list of 
elements contained on your FiberXpert OTDR 5000.

Fig. 90          Services Data page

Accessing to the FiberXpert 5000 Unit documentation
All documents necessary for the FiberXpert OTDR 5000 use are directly available onto 
the equipment.

To display the list of documents available for FiberXpert OTDR 5000 use:

1    Validate the Help icon on the Home page.

2    In the page, click one link to display the corresponding document: User manual, 
Getting Started Manual, Quick Card...
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Fig. 91          Help page

Installing a new version of the software
When a new software version is loaded, there is a risk of re-initializa- tion of the 
internal memory. Before installing the new software, it is therefore advisable to save 
the results in the memory, using the Save function called up by the FILE button.

Do not interrupt the installation process, as this could damage the instrument.
To avoid any interruption of the installation procedure, the FiberXpert OTDR 5000 
Unitmust be operating on the mains: if the procedure is started while operating on 
battery, a message indicates that the instrument must be connected to the mains.

Downloading from Internet
When the software is obtained from the Internet, it must be saved on a storage 
medium before the software upgrade of the product can be carried out. To do this:

1    Open Internet Explorer

2    On the PSIBER DATA web site  (http://www.Psiberdata.com), open the page of the 
product concerned
–  FiberXpert OTDR 5000

3    Click on the tab Downloads.

4    Click on the link FiberXpert OTDR 5000 Firmware Update  
A new page opens, displaying the current version available and several links.

5    According to your region, click on the one of the following icon to download the 
archive.

Download from European server  
Download from North American server  
Download from Asian server

6    In the new dialog box displayed, click on Save to save the exe file on the PC.

7    Once completed, connect the USB memory stick to the PC and follow the 
instructions chapter “Installation from a USB memory stick” on page 136, from step 2.
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Software versions installed on Unit
Software versions available on selected media for update

Installation from a USB memory stick
You must be equipped with a USB memory stick with a minimum capacity of 128 Mo.

Before installing the upgrade, you must format the USB memory stick  
(see “Formatting the USB memory stick onto the FiberXpert OTDR 5000” on page 145).

1    Once formatted, disconnect the USB memory stick from the FiberXpert OTDR 5000 
Unit using the key Eject USB in the Media Utilities page.

As for any media formatting, please note that all data present on the USB memory 
stick will be irremediably lost.

2    Connect the USB memory stick to the PC

3    Unzip the upgrade files on the PC and transfer it to the USB memory stick:
a    Download and save on your PC the.exe upgrade file that you can get from the web 
( http://www.Psiberdata.com, see “Downloading from Internet” on page 133).
b   Once the transfer is completed, double click on the.exe file: A window will appear. 
Check that the folder is correct i.e. the USB memory stick driver is appearing in the 
line at the bottom of the dialog box then press OK. If not, click on the icon  in order 
to select the right USB drive.

Fig. 94          list of software update

c    Press OK and wait for the end of loading.

4    Then remove the USB memory stick, using the appropriate proce- dure, from your 
PC

5    Insert the memory stick into one of the USB ports on the Unit.

nOTE
A bip is emitted each time the USB memory stick is inserted or removed from the  
USB port.

6    Press successively Expert Tools > Upgrades > Software Upgrade > Upgrade from 
USB.

The message Are you sure? is displayed

7    Click on Confirm.

The list of the software versions available on the USB stick is displayed next to the 
versions installed on the FiberXpert OTDR 5000 (see Figure 93 on page 135).
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launching the upgrade
Whatever is the method selected for upgrade (Server, USB key...) and once the list 
of the software versions available is displayed next to the versions installed on the 
FiberXpert OTDR 5000 (see Figure 93 on page 135), follow these instructions to launch 
the upgrade:

1    Click on Show Prev choice or Show Next Choice to display the previous and next 
versions available.

2    Click on Confirm this Choice to start the upgrade of the selected software(s).

or Click on Confirm All Choices to upgrade all versions.

NOTE 
The software versions list does not always appear (cf previous ver- sions) as well as 
the Previous / Next Choice buttons and the Con- firm/Continue key. In this case, the 
upgrading starts automatically.

Upgrading begins. The FiberXpert OTDR 5000 is automatically rebooted. Upgrading 
takes several minutes. Finally, the FiberXpert OTDR 5000 is automatically restarted.

During the upgrade, the Testing indicator is lit in red. Do not push any button or 
remove the USB memory stick while the indicator is lit. The USB stick can be removed 
if necessary once the Testing indicator is off.

Upgrading from the boot
This method is used to make a complete reinstallation of the software versions.

1    Turn off the FiberXpert OTDR 5000 using the ON/OFF button, keeping the equipment 
connected to the mains.

2    Insert the USB stick onto which the software versions are stored into one of the 
USB port of the Unit

3    Press simultaneously SETUP + START/STOP buttons

4    Maintaining the two buttons pressed, press ON button to start the FiberXpert OTDR 
5000.

5    A menu displays, then the screen allows to select Upgrade fromUSB

After a few seconds, a new page displays indicating that to continue the reboot, the 
validation key must be pressed.

Press the hard key.

The reboot starts automatically.

The Testing indicator will be lit in red during upgrade. Do not push any key or remove 
the USB memory stick until the lit turns off.

Once the upgrade is completed, the FiberXpert OTDR 5000 will automatically turns on 
and display the Home page.
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Install Option 
This page allows to import the licence to get a software option.

Fig. 96          Example of a license file (.lic)

To import the license, you can either enter manually the licence code, given in the 
license file, (.lic file) or import this file with a USB memory stick connected to the 
FiberXpert OTDR 5000.

It is strongly recommended to perform the installation using the importation of Licence 
via a USB memory stick.

Enter Manually the licence
1    In the Home page, click on Expert Tools > Upgrades > Install Option > Enter License

The edition keypad is displayed

2    Enter the challenge code of the option, set at the bottom of the file (see Figure 96 
on page 140),

Fig. 97          Enter the licence code

licence Code
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The license file can be opened via a word processing software such as Word...
The challenge code must be entered exactly as it is in the .lic file, paying attention to 
the lower-case and upper-case letters etc.

3    Press the Enter key to validate the code

Your software options will be installed

At the end of this sequence you will be asked to reboot the unit to apply the 
modifications, pushing the key.  Confirm the reboot to restart the Unit.

Import the license from the USB memory stick
1    In the Home page, select the Settings icon

2    In the System Settings page, press Expert Tools > Upgrades > Install Option > 
Import License

If the USB memory stick is not already connected to the Unit, a message asking the 
memory stick insertion is displayed. Confirm it once the stick is connected.

3    In the File Explorer, select the USB stick, then the license file (.lic) to be imported,

4    Click on Load > Confirm

5    The challenge codes contained in this file will then be loaded auto- matically and 
your software options will be installed.

Fig. 98          license imported

6    At the end of this sequence you will be asked to reboot the unit to apply the 
modifications, pushing the key. 

7    Confirm the reboot

locking the FiberXpert OTDR 5000
The FiberXpert OTDR 5000 can be locked at any time:

1    In the HOME page, click on Expert Tools

2    Click on Instrument Lock Out

3    Confirm the FiberXpert OTDR 5000 locking by clicking on Confirm (or use the Cancel 
key to cancel the process).

The numeric keypad is displayed

4    Enter the password to lock the instrument: 42000 with the numeric keypad 
displayed.
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Fig. 99          Password

5    Click on Enter

The FiberXpert OTDR 5000 locking screen is displayed.

Fig. 100        locking screen

Click on the Notepad Message key to add a message using the text edition.

Unlocking the FiberXpert OTDR 5000
1    Once the locking screen is displayed, click on the key Unlock Instrument.

2    Press confirm to confirm the Unitmust be unlocked.

3    Enter the password 42000 using the numeric keypad displayed and validate.

The screen automatically displays the HOME page.
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Returning an instrument
To return an instrument get in contact with Psiber Data to follow the appropriate RMA 
process

When returning an instrument, it is essential to indicate the following minimum 
information:

–    the type and serial number of the instrument (on the identification label) and the 
configuration code (under the bar code)

–    a description of the fault found on the instrument.

The returned instrument will then be repaired and calibrated.

Guarantee conditions
Any repair operation supervening within the guarantee period of the instrument will 
be carried out at the expense of PSIBER DATA. However, for any sub-assembly upon 
which work has been carried out otherwise than by PSIBER DATA Service Centers, 
the cost of a replacement sub-assembly will be invoiced.

Recycling Information
PSIBER DATA recommends that customers dispose of their instruments and 
peripherals in an environmentally sound manner. Potential methods include reuse of 
parts or whole products and recycling of products components, and/or materials.

Waste Electrical and electronic Equipment (WEEE) Directive
In the European Union, this label indicates that this product should not be disposed 
of with household waste. It should be deposited at an appropriate facility to enable 
recovery and recycling.

Troubleshooting Interpreting alarms
Troubleshooting                             Solution

Nothing happens when the ON/ OFF key is pressed. - Make sure that the battery is present or charged; or 
the mains adapter is properly connected (see “Con- 
necting the mains adapter” on page 16).

Nothing happens on screen, whatever is the action done 
(menu key or hard key pressed...)

- The Unit must be rebooted. See “Resetting the 
FiberXpert OTDR 5000” on page 18.

You are using the FiberXpert OTDR 5000 in the ordinary 
way when it suddenly switches off.

- Check the instrument is not configured to Auto off. See 
“Defining the Automatic shutdown of the 2000 Platform” 
on page 24). 
- Check the battery charge level. See “Charging the 
battery” on page 16.

The battery refuses to charge (the Charge indicator 
does not go on when the instrument is connected to the 
mains and is not operating).

- There is no battery in the instrument. 
- The temperature level of the equipment does not 
allow the battery charging for safety reasons. Wait the 
equipment cools down. 
- The battery needs to be changed. 
See “Changing the battery” on page 146.

When using the touchscreen, nothing happens - The touchscreen needs to be calibrate. See 
“Touchscreen calibration” on page 146
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Troubleshooting                             Solution

Error message when USB has been disconnected - The USB disconnection has not been done prop- erly 
(see “USB memory stick disconnection” on page 84)
- The data transfer was not completed when USB key 
was disconnected.

No beep is emitted when the USB memory stick is 
connected

- A previous USB memory stick has not been prop- erly 
disconnected (see “USB memory stick discon- nection” 
on page 84).
- The USB memory stick is not detected by the 
FiberXpert 5000 Unit: use another memory stick, or 
another stor- age media; or transfer data via USB cable 
(see “Transferring files to a PC with the USB cable” on 
page 74).

Error message when upgrade via Ethernet is confirmed - Check the Server Name is correctly entered (see 
“Installation from another server” on page 135)

Error message when upgrade via USB key is confirmed Check the USB key is correctly connected (see “USB 
memory stick connection” on page 84)

Error message when unlocking the instrument - The password is not the correct one (see “Locking the 
FiberXpert OTDR 5000” on page 142).

Formatting the USB memory stick onto the FiberXpert OTDR 5000

If the USB icon  is displayed on the upper banner of the screen, when a USB 
memory stick is connected to the FiberXpert OTDR 5000, this may means the memory 
stick must be formatted.

If the stick needs to be formatted, proceed as follows:

1    Insert the memory stick into one of the USB port on the top of the 

FiberXpert OTDR 5000.

2    Press the HOME button

3    Validate the Settings icon to open the System Settings page.

4    On the right menu keys, successively select Expert tools > Media utilities > 
Usbflash Format.

5    Confirm your choice to actually format the USB memory stick.

As for any media formatting, please note that all data present on the USB memory 
stick will be irremediably lost.

Erase disk To delete all the disk contents of the FiberXpert OTDR 5000:
1    On the Home page, Press twice the Settings icon to open the

System Settings page

2    Press Expert Tools >  Media Utilities,

3    Select Erase Disk to delete all the disk contents into the FiberXpert OTDR 5000 Unit.

A confirmation must be validated before the deletion.
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Touchscreen calibration
If you meet problems when using the touchscreen (example: pressing on an icon does 
not work correctly...) a calibration can be performed on the FiberXpert OTDR 5000 
touchscreen.

To calibrate the touchscreen, proceed as follows:

1    Push the HOME button

2    Press twice the Settings icon to open the System Settings page.

3    Press Expert Tools menu key

4    Press Touchscreen Calibration key

A blue slightly smaller screen appears, displaying a little target on the left hand corner.

5    Click on this target (preferably with the touchscreen pen).

6    A new target appears then and again, for a total of 4 times, in order to click on all 
corners of the screen.

If all the targets are not correctly touched, the touchscreen cannot be used. 
Otherwise, the touchscreen may be used directly.

Fig. 101        Touchscreen calibration

Changing the battery
If you meet problems during the Unit functioning, or if the battery does not charge 
anymore when plugged, this may require the battery to be replaced.

Accessing to the damaged battery

CAUTIOn
Battery is not interchangeable in the field. It must be replaced exclusively for 
maintenance purpose.

To access the battery of the FiberXpert OTDR 5000, proceed as follows:
1    Switch off the instrument and disconnect the mains supply.

2    Turn the instrument face down on the work surface.

3    If any, remove the module installed (see “Removing a module” on page 14).

4    Remove the battery door

5    Pull the battery connector from its housing, to disconnect it from the base, taking 
care not to damage the connector into which it is plugged.

Target
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Fig. 102        Battery installation

Date and Time parameters will be lost when battery is disconnected.

Installing a new battery
1    Set the battery into the Unit

2    Connect the new battery in the connector of the FiberXpert OTDR 5000, in the right 
way using the location notch.

Fig. 103        Setting a new battery

When putting a battery back into its seating, make sure that its connector engages 
correctly with the one of the base and that the door is correctly closed.

Contact PSIBER DATA local Sales Service to get a new battery.

Do not use any battery other than the one supplied with the instrument, or supplied by 
PSIBER DATA.

Battery door    Battery
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General information on warranty
The warranties described herein shall apply to all commercially available PSIBER 
DATA products. Any additional or different warranties shall apply only if agreed to by 
PSIBER DATA in writing. These warranties are not transferable without the express 
written consent of PSIBER DATA.

Hardware Warranty
PSIBER DATA warrants that Hardware Product sold to customer shall, under normal 
use and service, be free from defects in materials and workman- ship. Information 
regarding the specific warranty period for this product can be obtained by contacting 
your local PSIBER DATA Customer Service Representative, or at our web site www.
Psiberdata.com. If installation services have been ordered, the warranty period 
shall begin on the earlier of (1) completion of installation, or (2) thirty (30) days after 
shipment to customer. If Installation Services have not been ordered, the warranty 
period shall begin upon shipment to Customer. Hereafter these periods of time shall be 
collectively referred to as the Initial Warranty Period.

PSIBER DATA ’s obligation and customer’s sole remedy under this Hardware Warranty 
is limited to the repair or replacement, at Acterna’s option, of the defective product. 
PSIBER DATA shall have no obligation to remedy any such defect if it can be shown: 
(a) that the Product was altered, repaired, or reworked by any party other than PSIBER 
DATA without PSIBER DATA’s written consent; (b) that such defects were the result of 
customer’s improper storage, mishandling, abuse, or misuse of Product; (c) that such 
defects were the result of customer’s use of Product in conjunction with equipment 
elec- tronically or mechanically incompatible or of an inferior quality; or (d) that the 
defect was the result of damage by fire, explosion, power failure, or any act of nature.

PSIBER DATA performed repairs shall be warranted from defective material and 
workmanship for a period of ninety (90) days, or until the end of the Initial Warranty 
Period, whichever is longer. Risk of loss or damage to Product returned to PSIBER 
DATA for repair or replacement shall be borne by customer until delivery to PSIBER 
DATA.

Upon delivery of such product, PSIBER DATA shall assume the risk of loss or damage 
until that time that the product being repaired or replaced is returned and delivered 
to customer. Customer shall pay all transportation costs for equipment or software 
shipped to PSIBER DATA for repair or replace- ment. PSIBER DATA shall pay all 
transportation costs associated with returning repaired or replaced product to 
customer.

Warranty disclaimer
For hardware and/or services furnished by PSIBER DATA, the foregoing warranties 
are in lieu of all other warrantees and conditions, express or implied. PSIBER DATA 
specifically disclaims all other warranties, either express or implied, on any hardware, 
documentation or services including but not limited to warranties relating to quality, 
performance, noninfringement, merchantability or fitness for a particular purpose, as 
well as those arising from any course of dealing, usage or trade practice. under no 
circum- stances will PSIBER DATA be liable for any indirect or consequential damages 
related to breach of this warranty.
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